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Objetivos de este Tutorial 
 
El objetivo de esta práctica guiada es presentar a grandes rasgos el entorno de diseño que ofrece el paquete 
informático ISE® de XILINX Inc. para la captura de esquemáticos. En esta práctica se planteará el diseño de 
un bloque combinacional. 
 
La herramienta Xilinx-ISE (Integrated Software Environment) es una herramienta de diseño de circuitos 
profesional que nos va a permitir, entre otras funciones, la realización de esquemáticos y su posterior 
simulación y síntesis. 
 
El desarrollo de las prácticas se realizará siguiendo los siguientes puntos: 
 
• En primer lugar, se estudiará la especificación propuesta para determinar una posible solución. Este estudio 
se debe realizar antes de utilizar la herramienta informática, cuya introducción se describe en este texto, ya 
que es la parte fundamental para asimilar los conocimientos sobre diseño lógico. 
• A continuación se hará un estudio asistido por ordenador utilizando el paquete informático ISE® de 
XILINX Inc. Este paquete informático está formado por un conjunto de herramientas que permiten diseñar 
circuitos digitales mediante esquemas lógicos o utilizando lenguajes de descripción de hardware como VHDL 
o Verilog. También permite simular el comportamiento de los circuitos diseñados, y sintetizarlos sobre 
dispositivos lógicos programables de XILINX. 
 
La secuencia habitual de pasos se lleva a cabo del siguiente modo: 
 
• Se introduce el diseño que se quiere simular en el entorno de captura de esquemas de la herramienta, 
llamado Xilinx ECS. La captura del diseño puede realizarse mediante esquemáticos o utilizando lenguajes de 
descripción de hardware. 
• Se crea un testbench para comprobar el funcionamiento del circuito, mediante la herramienta HDL Bencher. 
• Se simula el funcionamiento del circuito llamando a la herramienta de simulación ISE Simulator. 
• Se comprueba que el funcionamiento del circuito es el deseado, analizando las formas de onda de las señales 
pertinentes. En caso de que los resultados no sean los esperados, se debe revisar el diseño empezando por la 
especificación de partida para localizar donde está el fallo, retocando entonces el esquema y repitiendo el 
ciclo de diseño. 
 
Para ver como se realizan todos estos pasos, así como para aprender el manejo de las distintas funciones de 
las herramientas, en el siguiente apartado se realizará una práctica guiada con un ejemplo sencillo. 
 
Cuando completes el tutorial sabrás como: 
 

•  Crear un proyecto ISE para una FPGA Spartan-3 
•  Crear un diseño con esquemáticos y verificar que es 

correcto 
•  Crear un banco de pruebas (test bench waveform) para 

simular el diseño 
•  Generar el patrón de bits de configuración del dispositivo 

(archivo bitstream) 
•  Sintetizar e implementar tu diseño 

 
 

Diseño a implementar 
 
La práctica consiste en el diseño mediante captura de esquemas de 
un multiplexor 2 a 1 con señal de habilitación. 
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Un multiplexor 2 a 1 tiene dos entradas de datos (D0, D1), una entrada de control (S), una señal de habilitación 
E y una salida (O). La función de conmutación del multiplexor 2 a 1 es la siguiente: 
 

( )10 SDDSEO +=  
 
Para implementar este circuito se necesitan una serie de puertas lógicas, como son: 2 puertas AND de 3 
entradas, 1 puerta OR de 2 entradas y 1 inversor.  
 
La idea de las herramientas de captura de esquemas consiste en que se pueda reproducir de forma gráfica 
aquello que haríamos sobre el papel, dibujando dichas puertas y conectando todos los componentes entre sí. 
 
Arrancando ISE 
 
Para usuarios Windows, se arranca el programa desde el menú Inicio seleccionando: 
Inicio > Programas > Xilinx ISE 7 > Project Navigator 
 
El ISE Project Navigator arranca.  
Aviso: Dependiendo del proceso de instalación, el path del programa podría ser otro.  
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Creando un Nuevo Proyecto en ISE 
 
En esta sección, crearás un proyecto en ISE. Un proyecto es una colección con todos los archivos necesarios 
para crear y descargar un diseño a cualquier dispositivo FPGA o CPLD de Xilinx 
 
Para crear un nuevo proyecto debes seguir los siguientes pasos: 
 

1. Selecciona File > New Project. Aparecerá el asistente de nuevos proyectos 
2. Primero, selecciona la localización (o path) del directorio en el que ubicarás el proyecto 
3. Teclea mux2a1 en el campo Project Name 

 
Cuando teclees mux2a1 en este campo, un subdirectorio del mismo nombre se creará automáticamente en la 
dirección que seleccionaste anteriormente 
 

4. Selecciona schematic en el campo Top-Level Module Type, indicando que el archivo 
jerárquicamente superior y que engloba los demás será un esquemático, en vez de HDL o EDIF. 

 
 

 
 

5. Pincha Siguiente para avanzar al siguiente paso 
6. Rellena las propiedades del dispositivo en que se va a realizar el diseño y que aparecen a 

continuación: 
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Device Family: Spartan3 
Device: xc3s200 
Package: ft256 
Speed Grade: -4 
Top-Level Module Type: HDL 
Synthesis Tool: XST 
Simulator: ISE Simulator  
Generated Simulation Language: VHDL que será el lenguaje en el que se 
ejecutará la simulación funcional.  

 
Aviso: Dependiendo del dispositivo en el que se sintetice el diseño, estos valores podrían ser otros, 
obviamente.  
 

7. Pincha Siguiente para obviar los pasos de añadir archivos nuevos o ya creados al proyecto. Esto lo 
haremos posteriormente 

8. Finalmente, las propiedades de tu proyecto aparecerán resumidas de la siguiente manera: 
 
 

 
 
 

9. Pinchar en Finalizar. 
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Captura de esquemas 
 
 
Una vez creado el proyecto, hay que crear un nuevo diseño de esquemático. Para ello hacer doble clic en 
Create New Source. 
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Aparecerá un cuadro de diálogo en donde debemos seleccionar el nombre del archivo (mux2a1) y el tipo de 
archivo (Schematic). 
 
 

 
 
 
Una vez seleccionado el tipo de archivo y el nombre, pulsar en Siguiente y en el siguiente cuadro de diálogo, 
en que figura el archivo que se generará, pulsar en Finalizar. 
 
Una vez hecho esto se abrirá el editor de esquemáticos. 
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En la parte izquierda hay dos pestañas etiquetadas como Options y Symbols. La primera de ellas permite 
cambiar ciertas opciones de comportamiento de la herramienta. La pestaña Symbols se puede seleccionar los 
componentes que queremos añadir al diseño. Al pinchar en ella presenta el siguiente aspecto, y desde ella se 
pueden seleccionar los componentes. 
 
 

 
 
 
El cuadro superior de Symbols está dividida en varios menús. Desde el primero de ellos, etiquetado como 
Categories, se puede escoger el tipo de elementos que se quiere usar, como puertas lógicas, comparadores, 
multiplexores, memorias, etc. También aparece en la parte inferior una pestaña que nos proporciona 
información sobre cada uno de los símbolos. Para nuestra práctica usaremos como elementos puertas lógicas 
AND y OR que están en la categoría Logic. 
 
Para empezar con el diseño añadiremos las dos puertas AND de tres entradas (and3) y la puerta OR de dos 
entradas (or2). Para ello seleccionaremos la opción Logic en Categories, y en Symbols buscaremos el 
componente and3. Una vez seleccionado pincharemos en el área de diseño 2 veces para insertar 2 puertas. 
Una vez colocados los 2 componentes, se pulsa la tecla ESC para dejar de insertar componentes. 
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Es conveniente hacer un zoom sobre la zona en la que vamos a trabajar para poder colocar mejor los 
componentes. Para hacer zoom sobre una zona hay que pinchar en el icono de la barra de herramientas y 
luego pinchar y dibujar un cuadrado sobre la zona donde queremos hacer el zoom. 
 
Una vez colocados las dos puertas AND buscamos el componente or2, el cual seleccionamos e insertamos en 
el esquemático. Una vez colocado, se pulsa la tecla ESC. El aspecto del esquemático debería ser el siguiente: 
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A continuación completar el diseño para que quede como la figura de abajo. Para ello tendremos que colocar 
el componente inv, realizar el cableado de conexión entre los componentes y colocar los puertos de entrada y 
salida. Estos últimos comandos se encuentran en la barra de herramientas. 
 
 

 
 
 
El nombre de los puertos puede modificarse haciendo doble-click en los mismos. Modificar el nombre de los 
puertos para tener D0, D1, E, S como puertos de entrada y O como puerto de salida. 
 
 

 
 
Una vez hecha esta operación, guardar el esquemático (Save). 
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Comprobación del circuito 
 
 

Una vez terminado el diseño del circuito puede hacerse una simple comprobación sobre el mismo para 
asegurarnos de que todas las conexiones están bien hechas y que no hay cables sueltos o puertas sin conectar. 
Para ello desde el menú principal se pincha en Tools y dentro de este menú desplegable en Check 
Schematics. Aparecerá una ventana que nos informará si hay algún Error o Warning. En nuestro caso no 
habrá ningún tipo de problema: 
 

 
 
Pulsamos Close. 
 

 
 
 
 
 
 
 
 
 
 



Tutorial de Xilinx ISE  13
   

Creación de un símbolo 
 
Con el diseño realizado se podrá hacer un nuevo componente, consistente en un “caja negra”, un bloque con 
el mismo número de entradas y salidas del circuito original diseñado y con su funcionalidad. Este nuevo 
símbolo creado pasa a formar parte de la librería de componentes del proyecto y podrá utilizarse como un 
componente más. Esto es fundamental para realizar diseños jerárquicos. 
 
Para crearlo desde el menú principal se pincha en Tools y dentro de este menú desplegable en Symbol 
Wizard. Nos aparecerá la siguiente ventana en la que marcaremos la opción Using Schematic dentro del 
nombre que se dará al símbolo. 
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A continuación aparecerá la ventana en la que se especifican las entradas y salidas del símbolo. 
 

 
 
En la siguiente ventana es posible especificar el tipo de fuente que se va a utilizar a la hora de crear el 
símbolo: 
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Pulsando Siguiente aparece el esquema del símbolo como “caja negra” con sus entradas y salidas: 
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Al pinchar en Finalizar el programa genera el símbolo y lo muestra en una hoja del editor de esquemáticos: 
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Si nos fijamos en la parte inferior de la ventana del editor de esquemáticos, podemos ver que hay dos pestañas 
una correspondiente al esquemático del circuito que hemos realizado MUX2a1.sch y otra que se corresponde 
con el símbolo creado MUX2a1.sym. 
 
En el esquema del circuito original, si nos fijamos en la ventana de la parte derecha, Categories, vemos que 
hay una nueva categoría, que corresponde a la librería del proyecto que hemos abierto y donde se ha 
almacenado el símbolo creado. Al seleccionar esa categoría, en la parte inferior, Symbols, encontramos el 
componente creado. 
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Simulación del Diseño 
 
Creación de un banco de pruebas para simular 
 
Una vez que se ha revisado el circuito y está libre de errores habrá que comprobar su correcto 
funcionamiento. Para ello habrá que realizar una simulación del circuito diseñado. La etapa de verificación 
funcional se va a realizar con la herramienta de simulación ISE Simulator. Para poder simular el circuito 
primero debemos crear un banco de pruebas (testbench waveform) donde se introducen los valores que se 
asignan a las entradas y en función de los cuales se obtendrá una salida que deberá coincidir con el valor 
esperado de acuerdo a la funcionalidad de nuestro circuito. 
 

1. Selecciona el archivo mux2a1 en la ventana Sources in Project. 
2. Crea un nuevo archivo seleccionando Project > New Source. 
3. En la ventana emergente New Source, selecciona Test Bench Waveform como tipo de archivo y 

escribe mux2a1_tbw en el campo File Name. 
 
 

 
 
 

4. Pulsa Siguiente. 
5. Un cuadro de diálogo te muestra que asocias el tech bench o banco de pruebas con un fichero fuente: 

mux2a1. Pulsa Siguiente 2 veces.  
6. Pulsa Finalizar. 

 
 
 
 
 
 



Tutorial de Xilinx ISE  19
   

Necesitarás un conjunto de valores iniciales para tu banco de pruebas, por lo que se abrirá el cuadro de 
diálogo Initialize Timing antes de que puedas editar las entradas en el banco de pruebas. 
 
 

 
 

7. En Clock Information, seleccionamos Combinatorial. Rellenamos los campos con los valores. 
•  Check Outputs: 50 ns 
•  Assign Inputs: 50 ns 
•  Inicial Length of Test Bench: 2000 ns 
•  Global Signals: GSR (FPGA) 

 
8. Pulsa OK para abrir el editor de formas de onda. 

 
Aviso: Encontrás más sencillo trabajar en el banco de pruebas si la ventana ocupa toda la ventana. Pulsa 
“>>”. 
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9. En este diseño, debemos simular teniendo todas las combinaciones posibles de estímulos en los 
puertos de entrada. Pulsa en las zonas sombreadas de azul para modificar los valores y obtener la 
combinación de estímulos de la figura: 

 
 
 

 
 

10. Selecciona File > Save para guardar las formas de onda. En la ventana Sources in Project, se añade 
automáticamente el archivo TBW. 

11. Cierra la ventana del editor de estímulos. 
 
 
 
Añadiendo la estimación de los resultados esperados al Banco de 
Pruebas 
 
En este apartado crearás automáticamente un banco de pruebas con las salidas esperadas que corresponden a 
las entradas que pusiste anteriormente con el editor de estímulos. Los retrasos en las entradas y las salidas que 
introdujiste cuando comenzaste a usar el editor de estímulos son evaluados cuando el diseño está siendo 
simulado. Para realizar esta prueba, debes ejecutar el comando Generar Resultados Esperados: 
 

1. Selecciona el archivo mux2a1_tbw.tbw en la ventana Sources in Project.  
2. Haz doble-clik en el proceso Generate Expected Simulation Results que está dentro del 

apartado ISE Simulator. Este proceso convierte el archivo TBW en HDL (lenguaje de descripción 
hardware) y lo usa para simular el diseño en un proceso que se ejecuta en el fondo. 
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3. Se abrirá la ventana contextual Expected Results. Selecciona Sí para sobrescribir los resultados 
en el editor de estímulos, que se abrirá automáticamente. 

 

 
 
 

4. Selecciona File > Save para guardar el test bench. 
5. Cierra el editor de estímulos. 

 
Ahora que tienes el banco de pruebas con las entradas y salidas especificadas, estás listo para simular tu 
diseño. 
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Simulando el Modelo Funcional con ISE Simulator 
 
 
Para ejecutar un proceso de simulación con ISE Simulator debes: 
 

1. Seleccionar el banco de pruebas (test bench) en la ventana Sources in Project. Puedes apreciar los 
procesos de Xilinx ISE Simulator en la ventana Processes for Source. 

 
 

 
 
 
Aviso: Únicamente verás los procesos del ISE Simulator si seleccionas este simulador al principio del 
proyecto como simulador activo.  
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2. Haz doble-click en el proceso Simulate Behavioral Model. El simulador se abrirá y ejecutará una 
simulación hasta el final del banco de pruebas (2000 ns en nuestro caso). 

3. Para ver los resultados de tu simulación, selecciona la pestaña correspondiente al banco de pruebas. 
Puedes usar el zoom para ver con más detalles algunas zonas. La ventana creada tiene el siguiente 
aspecto: 

 
 

 
 
Podemos observar que el comportamiento de nuestro diseño es el deseado. Es de esperar que hayamos 
diseñado correctamente el sistema. 
 

4. Cierra la ventana de la simulación. 
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Creando y Editando Restricciones al Diseño 
 
En todos los diseños, suelen especificarse una serie de restricciones físicas y temporales para poder sintetizar 
el diseño de manera satisfactoria. En un proyecto con ISE existe una gran variedad de métodos para añadir 
restricciones, aunque sólo veremos las básicas en este tutorial. 
 
Por ejemplo, una de las placas de desarrollo que usaremos para sintetizar el diseño contiene la FPGA Spartan-
3 que seleccionamos como dispositivo de síntesis al principio de diseño.  
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La  FPGA está conectada físicamente a una serie de periféricos a través de unos pines específicos. Estos 
periféricos son los siguientes: 
 

 
 

Nuestro diseño consta de 4 entradas y 1 salida, luego sería muy interesante poder modificar los valores de 
entrada por medio de 4 de los 8 interruptores de los que disponemos y visualizar la salida por medio de uno de 
los 8 LEDs que trae la placa de desarrollo, con el fin de verificar visualmente que el diseño sintetizado 
funciona de manera correcta. 
 
 
Asignando Pines en la FPGA 
 
Para asociar pines de la FPGA con entradas y salidas específicas debes: 
 

1. Hacer doble-click en el proceso Assign Package Pins que está ubicado en el apartado User 
Constraints. A continuación se debe crear un archivo que especificará las restricciones impuestas. 
Pulsar Sí en la ventana emergente que aparece. El subprograma Xilinx Pinout and Area Constraints 
Editor (PACE) se abrirá. 

2. Puedes apreciar la lista de Pines de Entrada/Salida que tiene tu diseño en la ventana Design Object 
List. Introduce asignación de pin por cada puerto de E/S que tienes en la columna Loc, con los 
valores que figuran a continuación: 

 
•  D0: F12 
•  D1: G12 
•  E: H13 
•  O: K12 
•  S: H14 
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3. Pulsa en la pestaña Package View en la parte inferior de la ventana para ver los pines que acabas 
de añadir (de color azul). Si pasas con el ratón por encima de los pines de color azul, puedes verificar 
las asignaciones que acabas de realizar. 

 

 
 

4. Selecciona File > Save. Selecciona XST Default <> y pulsa OK. 
5. Cierra PACE. 

 
 
 
 

Síntesis del Diseño e Implementación  
 
Ahora que has creado los esquemáticos, verificado el diseño mediante una simulación funcional y añadido las 
restricciones pertinentes, estás listo para sintetizar e implementar tu diseño. 
 
 
Implementando el Diseño 
 

1. Selecciona el archivo mux2a1en la ventana Project window. 
2. En la ventana Processes for Source, pulsa en el signo “+” junto a Implement Design. Estos 

procesos serán ejecutados durante la implementación de tu diseño. 
3. Haz doble-click en el proceso que engloba todo, es decir, en Implement Design. 
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ISE determina el estado actual de tu diseño y ejecuta los procesos necesarios para poder implementar tu 
diseño teniendo en cuenta las restricciones, la FPGA a usar y otros muchos parámetros. 
Una vez que todos los procesos han finalizado, puedes comprobar que han aparecido marcas de verificación 
en los procesos que aparecen en la ventana Processes for Source. 
 
 
Verificación de la Síntesis 
 
Tu diseño se puede observar como un esquemático en el denominado Visor de Nivel de Transferencia de 
Registros, o Register Transfer Level (RTL) Viewer, en que se muestra las puertas y elementos a implementar 
independientemente del dispositivo de Xilinx® seleccionado para realizar el diseño. 
 

1. En la ventana Processes for Source, haz doble-click en View RTL Schematic situado en el grupo 
Synthesize - XST process.  Aparecerá el esquemático de jerarquía superior de tu diseño, que engloba 
todo. 

2. Haz doble-click en el esquema para observar niveles jerárquicos inferiores y ver el esquemático en 
detalle. 

 
 

 
 
 
Aviso: No puedes editar este archivo. 
 
 

3. Cierra la ventana. 
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Verificación del Diseño Implementado 
 
Una vez que la implementación se ha completado, puedes verificar tu diseño antes de bajarlo al dispositivo 
FPGA. 
 
Ver el Informe de Recursos Empleados 
 
Muchos de los procesos que hemos ejecutado para realizar la síntesis generan información acerca de tu 
diseño. Así, están disponibles informes detallados a través de Design Summary. 
 

1. Pulsa en la pestaña Design Summary  en la parte inferior de la ventana. 
 

 
Nuestro diseño emplea 5 bloques de E/S (2%) y únicamente 1 LUT (1%) de nuestra Spartan-3. 
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Crear los Datos de Configuración 
 
La última fase en el flujo de diseño consiste en generar un archivo de bits (biststream) y configurar nuestro 
dispositivo. 
 
Generar el Bitstream 
 
El bistream es un archivo binario que es el equivalente a nuestro diseño en un formato que puede bajarse a 
nuestra FPGA. 
 

1. Selecciona mux2a1 en la ventana Sources in Project. 
2. Ejecuta el proceso Generate Programming File localizado al final de la ventana Processes for 

Source. 
 
El programa Bitgen crea el bistream que es un archivo llamado mux2a1.bit, que es el archivo de 
configuración. 
 

3. Selecciona la pestaña Design Summary.  
4. Ahora, en la parte final, puedes seleccionar Bitgen Report para ver el informe correspondiente. 

 
Ahora estás preparado para configurar tu dispositivo. 
 
Configurar el Dispositivo 
 
Para configurar nuestra FPGA (una Spartan-3 en este caso) usaremos iMPACT. Este es el último paso en el 
proceso de diseño. En esta sección se explica de manera simple las instrucciones para configurar una Spartan-
3 xc3s200 conectada al PC mediante el puerto paralelo. 
 
 
Aviso: La placa debe conectarse al PC antes de proceder. Si el dispositivo de tu placa de desarrollo no 
coincide con el asignado al proyecto, se producirán errores. 
 
Para configurar el dispositivo: 

1. Pulsa “+” para expandir los procesos de Generate Programming File. 
2. Haz doble-click en el proceso Configure Device (iMPACT). 
3. Verifica que está seleccionado el modo Boundary-Scan Mode en la ventana de configuración de 

dispositivos que se abre y pulsa Siguiente. 
4. Verifica que está seleccionada la opción Automatically connect to cable and identify 

Boundary-Scan chain y pulsa Finalizar. 
5. Si observas un mensaje que dice que se han encontrado dos dispositivos, pulsa OK para continuar. 
6. Aparece la ventana Assign New Configuration File. Asígnale el archivo de configuración al 

dispositivo. Selecciona el archivo mux2a1.bit y pulsa Open. Pulsa para Bypass continuar. 
7. Si ves una mensaje de Warning, ignóralo y pulsa OK. 
8. Pulsa el botón derecho del ratón sobre la imagen del dispositivo y selecciona Program... para abrir 

el menú Program Options. 
9. Pulsa OK para programar el dispositivo. 

 
ISE programa el dispositivo y aparece el mensaje Programming Succeeded si la operación se realizó con 
éxito. En el dispositivo, cuatro entradas y una salida deberían estar activas. 
 

10. Cierra iMPACT sin guardar. 
Acabas de completar el tutorial. 
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Resumen del Proceso de Diseño 
 
En general, para diseñar un sistema electrónico digital se han realizado los siguientes pasos: 
 

 


